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Start thinking about your 
database now. What do 
you want it to do? What 
information do you need 
to store in the database?

The New icon pictured 
above indicates new 
features of Access.

Introducing Access
Access is the latest version of Microsoft’s popular Relational 
Database Management System (RDBMS). The Access application 
(“app”) lets you manage all types of data with ease:

• Store and manipulate data in Tables

• Retrieve specific data by making Queries

• Provide user-friendly data entry Forms

• Supply attractively-styled data Reports

• Share data with colleagues using Access

Access is, however, much more than a means of storing and 
retrieving data. If you want to, you can build complete software 
apps limited only by your requirements and creativity.

You don’t need to be a computer programmer to use Access as 
you can use nearly all of Access’s functionality without entering a 
single line of code. All that is required is some forward planning 
and a clear idea of what purpose the database should serve.

What is a database?
A database is simply an ordered collection of records. For example, 
the Rolodex you may have on your office desk is a type of 
database. Open it up and you have the names, telephone numbers, 
and addresses of your business contacts.

In a computer, database information is organized in a much more 
structured way but the general idea is the same. Access keeps data 
in Tables. A Table is like the Rolodex – it contains all the data we 
need. Each row of the Table contains data about a specific thing. 
In a Rolodex it would be a business card. The columns of the 
Table help us to organize the data. Each column contains some 
specific item of data, such as the address of a contact.

The next chapter describes how databases are structured and 
demonstrates how to create them, but the rest of this chapter is 
devoted to getting you started with the Access app.
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Launching the Access app
Access is typically launched by clicking the Access item on the 
Windows Start menu, to open the “Start” screen. Here you see 
a range of ready-made templates, and a list of recently-opened 
Access files that you can click to reopen:

Access can also be 
launched by double-
clicking on an existing 
database file icon. In that 
case, Access immediately 
opens that database in 
its user interface, by-
passing this Start screen.

l1 Click on the Blank database template icon to begin 
creating a brand new Access database

l2 See a dialog box open 
that suggests a default 
name for the database 
and a default location 
on your computer

l3 Accept the suggested 
defaults, or edit the 
dialog box to provide 
your preferred name and 
location – for example, 
rename the database as 
“FirstDatabase” and choose a C:\MyDatabases folder

l4 Click on the Create button to complete the creation of 
the new database at your chosen location – the database 
will now open in the Access user interface

You may, optionally, omit 
the .accdb file extension 
when choosing a name – 
the file extension will be 
added automatically.
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Press the Alt key to 
see keyboard shortcuts 
appear next to each 
Ribbon icon – press a 
shortcut key to activate 
the associated icon.

Exploring the user interface
The Access user interface comprises several components that 
allow you to work efficiently with databases. In common with 
other apps in the Microsoft Office suite there is a “Ribbon” that 
intelligently groups related command icons on several menu tabs. 
Below the Ribbon is a Navigation Pane, containing icons that 
represent objects within the current database, and a Table window 
in which to view and edit the database content. Additionally, there 
is an editable Quick Access Toolbar for commands you frequently 
use, and a Status Bar that provides useful information:

Quick Access 
Toolbar

Menu tabs 
(click to select)

Ribbon 
groups

Command icons 
(click to execute)

Table windowNavigation PaneStatus Bar

The Table window provides two possible views of the database:

• Datasheet View – displays the data within the database and 
allows you to enter and edit data, but does not allow you to 
change the format of the database.

• Design View – displays the format of the database and allows 
you to change the format of the database objects.

To choose the view of an opened Table:

l1 Select the Home tab

l2 Click the View icon in the “Views” 
group, then choose a view option – 
for example, choose Design View

When you have a lot of 
windows open and space 
is at a premium you 
can close the Ribbon by 
double-clicking the tab 
that is currently selected 
– click any tab to reopen 
the Ribbon.
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...cont’d

l3 See Design View open in the Table window and notice 
that the Design tab has become automatically selected

The Navigation Pane makes finding database objects such as 
Tables and Queries easier by filtering them according to their 
type, the date they were created, and their group:

l1 At the top of the Navigation 
Pane, click the arrow button

l2 From the drop-down menu that 
appears, select a category by 
clicking the category name once 
– such as “Filter By Group”

l3 If any object groups exist, you 
can further refine your filter by 
clicking once on a group name

Navigation Pane with the 
Queries database object 
type filter applied

You will add database 
objects as you construct 
an Access database. 
Select any object in 
the Navigation Pane 
to open it in the Table 
window for modification.

The Navigation Pane 
displays all the database 
objects – Tables that 
store data, Queries that 
search data, Reports 
that explain data, and 
Forms for data entry.

When first switching to 
Design View, a dialog 
may appear allowing 
you to choose a table 
name – you can use 
the suggested name 
(“Table1”) or choose 
another name.
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To add any action to the 
Quick Access Toolbar 
simply right-click it on 
the Ribbon and select 
the Customize Quick 
Access Toolbar option.

Buttons on the Quick 
Access Toolbar appear 
“grayed out” if that 
action is not available. 
Here, Save and Undo 
actions are available, but 
Redo is unavailable.

Customizing Quick Access
The Quick Access Toolbar provides quick and convenient access 
to commonly-used commands such as Save, and is normally found 
at the top left of the Access screen.

By default, the Quick Access Toolbar features only three buttons 
– Save, Undo, and Redo. Although these are useful in themselves, 
the choice of action is somewhat limited. As your confidence with 
Access increases, you will soon want to have certain actions within 
easy reach. Happily, you can customize the Quick Access Toolbar, 
and add or delete extra buttons.

Customizing the Quick Access Toolbar

l1 Click the arrow at the end of the Quick Access Toolbar – 
to open a drop-down menu

l2 Click a menu item to add 
that command to the Quick 
Access Toolbar. Some of the 
most useful commands can 
be added to the Quick Access 
Toolbar using the drop-
down menu, but many more 
commands are available

l3 Click the More Commands... 
menu item – to open the 
“Access Options” dialog, 
shown opposite
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...cont’d

Select the 
action to 
add here

Change the 
order in which 
actions are 
displayed on 
the Toolbar

Click here 
to add the 
selected action

Click here to 
see different 
groups of 
actions

If you make a 
mistake, click Reset 
to undo your changes

Click here to 
confirm your 
choices

Click here to 
cancel your 
choices

Repositioning the Quick Access Toolbar

l1 Click the arrow at the end of the Quick Access Toolbar

l2 Click the Show Below the Ribbon menu option to 
position the Quick Access Toolbar below the Ribbon

It’s often convenient 
to distinguish between 
different groups of 
actions according to 
their function, for 
example separating file 
access actions from Table 
creation actions. In order 
to separate actions on 
the Quick Access Toolbar, 
choose the Separator 
action.

To return the Quick 
Access Toolbar to its 
default position, click the 
arrow button, then click 
the Show Above the 
Ribbon menu option.
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Managing files Backstage
The File button on the Access menu opens the “Backstage” screen 
where you can perform both file management and database 
administration tasks. The Backstage screen allows you to Open, 
Save, and perform maintenance operations on your database.

Opening a database

l1 Click the File menu button

l2 Click Open from the Backstage menu

l3 Select Recent, OneDrive, or This PC to choose the 
database location – for example, select This PC

l4 Select the folder containing the database – for example, 
select a folder at C:\MyDatabases on your computer

l5 Double-click the database file icon to open that database

You can click on the 
Folders item to navigate 
to other folders.

To open the Backstage 
screen quickly, press the 
Alt + F keys.
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Only enable content 
if you are absolutely 
certain that it doesn’t 
contain malicious code. 
In most cases, such code 
would only be present 
if you were opening a 
database from 
someone else.

To save a database 
quickly at any point, 
press the Ctrl + S keys.

...cont’d

By default, Access opens a database in a restricted mode of 
operation. Specifically, it disables the execution of “Visual Basic 
for Applications” (VBA) code and Macros. To enable all the 
features of the database, click the Enable Content button on the 
“Security Warning” that appears between the Ribbon and the 
main database window, or click the link to see more information:

This opens the Backstage screen, where you can discover what 
content has been disabled. Click the Enable Content button then 
choose the Enable All Content option to enable all the features of 
the database, or choose Advanced Options to enable only specific 
features of the database.

Saving a database

l1 Click the Save button on the Quick 
Access Toolbar

l2 Or, click the File button to open 
Backstage, then click the Save option
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By default, Access 
suggests the name 
“Database” followed 
by a number – for 
example, “Database1”. 
Avoid naming your 
databases in this manner, 
as having similarly-
named databases can be 
confusing and may cause 
errors.

...cont’d

Creating a new database

l1 Click the File button to open Backstage

l2 Click the New menu option

l3 Click the Blank database icon

l4 Enter a name for your new database in the 
dialog, and choose a location at which to 
save the database on your computer

l5 Press the Create button

Closing a database and exiting Access
Although Access is a great app, there will come a time when you 
want to close a database and switch off Access:

l1 Click the File button to open Backstage

l2 Click the Close menu option – to close the 
currently-open database

l3 Click the X button at the top right of the 
Access window, or press the Alt + F4 keys
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Personalizing Access options
The “Access Options” dialog contains various settings that affect 
the way you view and interact with Access. For example, you can 
decide whether or not you want feature descriptions to appear in 
the Screen Tips such as the one below, which appears when you 
place your cursor over the Table icon on the Create menu:

l1 Click on the File button to open Backstage

l2 Click on the Options menu item, located at 
the bottom of the Backstage menu

l3 Click the menu items at the left-hand side of the “Access 
Options” dialog to switch between sets of options

l4 Click on the drop-down menus to change option settings

Notice that you can 
specify a default 
database folder of your 
choice in this example.

Access has introduced 
the option to have 
Colorful, Dark Gray, 
Black, or White themes.
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After you’ve converted 
a database to the newer 
ACCDB file format you 
will no longer be able 
to use it with the earlier 
version of Access.

By default, a converted 
database retains the 
original name but 
gets the different file 
extension.

Converting older databases
Access makes it easy to open and work with a database created 
with an older version of Access, such as those in the MDB (.mdb) 
file format used by Access 2003. The older database will look and 
feel exactly the same as a database created with later versions of 
Access – but you won’t be able to make use of the newer features 
available in modern Access. Luckily, Access can quickly convert 
your old database to the newer ACCDB (.accdb) file format so 
that you can use the newer features in modern Access:

l1 Open the database you want to convert in modern Access, 
then click the File button to open Backstage

l2 Click the Save As menu option

l3 Choose Save Database As under the “File Types” heading

l4 Double-click Access Database (*.accdb) under the “Save 
Database As” heading – to open a “Save As” dialog

l5 Choose a 
location, then 
click the Save 
button to create 
a converted copy 
of the old-format 
database

l6 Click the OK button to dismiss the warning dialog

Although it’s always 
a great idea to back 
up files, it is not 
necessary to backup an 
Access database when 
converting to other 
file formats, as Access 
generates a new COPY 
of the current database. 
It does not replace the 
current file. This means 
that converting in either 
direction leaves you with 
both an ACCDB file and 
an MDB file.
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...cont’d

Converting databases to older formats
You may sometimes need to convert your modern Access database 
to a file format that will work with previous versions of Access:

l1 Open the database you want to convert in modern Access, 
then click the File button to open Backstage

l2 Click the Save As menu option, then choose Save 
Database As under the “File Types” heading

l3 Double-click Access 2002-2003 Database (*.mdb) under 
“Save Database As” – to open a “Save As” dialog

l4 Choose a location, 
then click the 
Save button to 
create a converted 
copy of the new-
format database

Consider your options 
carefully before you 
convert a database to an 
older file format, as you 
will no longer be able to 
use the new features of 
modern Access.

The ACCDB file format 
was introduced in Access 
2007. So that year is 
shown when converting 
from the old MDB 
format.
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Templates are 
downloaded from an 
online repository so 
you will need to have 
an internet connection 
to open templates that 
are not already on your 
computer.

Scroll through the list 
of popular templates 
to discover some great 
ideas on how you might 
use the Access app.

Access provides many high-quality templates that, for most 
people, can be used straight out of the box. For example, if your 
sole reason for investing in a Relational Database Management 
System is to maintain the contact details of your customers, then 
the Access “Contacts” template might be perfect for your needs.

The best way to see if Access templates are right for your 
organization is to open them up and see what they do:

Opening a template

l1 Launch Access from the Windows Start menu to see the 
Access Start screen – or close all open databases, then 
click the File button to see the Access templates

l2 From the scrollable list of popular templates on the Start 
screen, click on the Contacts template

Using Access templates

l3 Enter a name 
and location in 
the dialog, then 
click the Create 
button to create 
a database from 
the template



21

You will need to have an 
internet connection to 
watch the online video.

...cont’d

l4 You will now see a Welcome screen appear that provides 
a brief description of the database and offers assistance

l5 Click the arrow button to watch an online video 
demonstrating how to use this database

l6 Click the Get Started button to open the database in 
your Access app

l7 Make all features available so you can begin to use this 
database by clicking the Enable Content button

You can safely Enable 
Content when using 
Microsoft Office 
templates to enable their 
Macro code functions.
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The search will return 
templates for use with 
all Microsoft Office apps, 
including Word, Excel, 
and PowerPoint – not 
all results can be used 
as templates for Access 
databases.

Simply click on the 
template icon in 
the search result to 
download and use that 
template in Access.

Searching for templates
If you’re looking for a template to use in Access, but you can’t 
instantly see an appropriate template in the list of popular 
templates on the Start screen, you can easily search the thousands 
of Microsoft Office online templates to find something suitable. 
For example, you might want to create a database to retain 
important details of personal belongings for insurance purposes:

l1 Launch Access from the Windows Start menu to see the 
Access Start screen – or close all open databases, then 
click the File button to see the templates

l2 Next, type “personal belongings” into the Search box at 
the top of the Start screen

l3 Now, click the Search button, or hit the Enter key, to 
perform a search for a suitable template

l4 The search finds a suitable “Home Inventory” template, 
and the result indicates the categories in which this 
template can be found
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You can see the 
complete list of all 
categories in the right-
hand pane. These are 
also hyperlinks, which 
you can click to reveal 
the templates within 
each category.

...cont’d

As an alternative to searching by typing text into the Start screen’s 
Search box, you can also search categories for a suitable template. 
Links to popular categories appear as hyperlinks below the Search 
box. To find a template for a database of personal belongings, it is 
reasonable to explore the “Personal” and “Inventories” categories:

l1 Open the Access Start screen, then click the Personal 
hyperlink to explore that category

l2 The suitable “Home Inventory” template is found 
alongside other templates in the Personal category

l3 Return to the Access Start screen, then click the 
Inventories hyperlink to explore that category

l4 The suitable “Home Inventory” template is found 
alongside other templates in the Inventories category

The items that appear 
as “Suggested searches” 
may vary according to 
your previous template 
search history.
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Getting some Help
If you need assistance at any time in the Access app, you can call 
upon the Access Help feature:

l1 Open any database in Access, 
then simply press the F1 key (or 
press Fn + F1 keys) to see a Help 
window appear in the Access app

l2 You can click on any item you 
want to get help with. For example, 
if you are looking for help when 
you’re new to Access, click the Get 
started item

l3 Click the Play button to watch a 
video introducing the Access app

l4 Click the arrow beside the Search 
box to return to the Help window

l5 Choose another item, such as 
Tables, to see a list of topics

l6 Select a topic from the list, such as 
Introduction to tables, to see more

l7 Now select a sub-topic, such as Overview, for help
You invoke the Help 
feature in the same way 
in each Microsoft Office 
app, though the Help 
window that opens is 
specific to the active 
app; in this case, Access. 
The layout is similar for 
all Office apps.

To use Access Help, you 
must have an internet 
connection. Unlike old 
versions of Access, there 
is no Offline Help option.
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...cont’d

l2 Click on any result topic – such as Frequently used 
shortcuts – for help on that specific subject

You can also seek assistance by typing a query word or phrase into 
the Tell me what you want to do box on the Access title bar:

l1 Enter “keyboard shortcuts” into the Tell Me box

Whichever topic you 
select, you will still have 
the Search box so you 
can locate new topics, or 
click the X button on the 
Help window to close it.

You can search for assistance in a Help window:

l1 Enter keywords for a subject, such as “keyboard shortcuts”

l2 Click the arrow button on the context menu that appears 
– to reveal a list of suggested options

l3 Select the Keyboard shortcuts for Access option to open 
the Help window for that topic, as shown above center

The Tell Me box is a 
great feature in modern 
Access. Type in anything 
you like, and Access will 
attempt to help you.
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Applying Access updates
Microsoft will, by default, automatically update Access with new 
features as they become available. If you prefer not to enable 
automatic updates for the Access app, you can manually check for 
and apply updates at any time:

l1 In Access, click the File button to open Backstage

l2 Click the Account menu option to see your Microsoft 
Office User Information and Product Information

l3 Click the Office Updates, Update Options button to 
open a menu offering various settings options

l4 Choose the Update Now 
option to apply all available 
updates immediately

l5 Choose the Disable Updates 
option to stop receiving 
automatic updates

When you revisit these update options you will see an Enable 
Updates option that you can choose to resume automatic updates.

You can also change the 
Office Background and 
Office Theme settings 
to your preference using 
the drop-down menus 
on the Account screen.

Choose the View 
Updates option to 
discover which new 
features have been 
recently installed.


	TOC_web
	01_web

